Introduction to AutoCAD

Chapter Objectives

- Explore CAD's uses and benefits
- Understand fundamental CAD concepts
- Start AutoCAD
- Tour the AutoCAD user interface
- Explore the different AutoCAD data input methods
- Display and manipulate multiple AutoCAD drawings simultaneously
- Maximize AutoCAD's online Help System and Quick Info features

INTRODUCTION

This textbook is designed to allow you to “hit the ground running” using AutoCAD so that you can quickly start creating accurate technical drawings using accepted industry drafting standards. The next chapter (Chapter 2, Quick Start) shows you the minimum you need to know in order to create and plot an AutoCAD drawing starting from scratch. These introductory concepts and techniques are then linked to detailed information about each topic so you can explore them at your own pace.

Before you can do any of that though, we need to cover some basics. This chapter introduces you to some fundamental CAD concepts and the AutoCAD user interface so you are prepared to hit the ground running in Chapter 2.

WHAT IS CAD?

In a little over a generation’s time the methods used to create technical drawings have fundamentally changed from using pencil and paper to the use of Computer Aided Drafting, better known as CAD. The analog world of drafting boards, T squares, triangles, and even the romantic french curve (see Figure 1-1) has given way to the brave new digital world of computers. No longer must you refill your mechanical pencil when you run out of lead, find your eraser when you make a mistake, or walk across the room to share a design with another person.

Using CAD, you can draw something once and copy it hundreds, or even thousands, of times. Changing a design can be as simple as pushing a button. Drawings can be shared instantaneously across the room or even around the world over a computer network. These and the other benefits of CAD include the following:

- Increased productivity
  - Drawing content can be continuously reused.
  - Text and dimensions can be created and updated automatically.
  - Hatch and pattern fills can be placed with a single pick.
  - Revising and editing drawings can be done quickly with minimum effort.
Part One  An Introduction to AutoCAD

Figure 1-1  A T square, a triangle, and a french curve

- Improved precision
  - Digital information is accurate to 14 decimal places.
  - Geometry is precisely located using the Cartesian coordinate system.
  - It is possible to snap to control points and features on existing drawing geometry to accurately locate drawing information.
  - Polar and object tracking features can be utilized for precise angular measurements.
- Better collaboration
  - Drawings can be shared across a network (locally and globally).
  - Drawings can be referenced and updated in real time with notification.
  - Revisions and markups can be managed electronically via email and Internet-based document management systems.
- 3D visualization and analysis (See Figure 1-2.)

Figure 1-2  Sample 3D rendering created in AutoCAD
Chapter 1 Introduction to AutoCAD

- 3D animations and walk-throughs can be easily generated to allow you and potential clients to visualize a design before it is constructed.
- Interference checking can be done to ensure that parts do not run into each other before they are created.
- Engineering calculations such as Finite Element Analysis (FEA) and other structural calculations can be performed automatically.
- Computer prototypes can be created and tested, eliminating the time and materials needed to manufacture a real-world prototype.

All these benefits, except for 3D visualization and analysis, which is beyond the scope of this text, are explored in this textbook. The following chapters explain how to utilize the tools provided in AutoCAD to create and share the most accurate technical drawings in the quickest and most efficient manner. Using AutoCAD you will learn how to do the following:

- Set up and lay out different types of AutoCAD 2D drawings using AutoCAD model space and paper space techniques.
- Quickly create accurate 2D drawing information using AutoCAD’s precision drafting aids.
- Edit and modify 2D drawing information in a productive fashion.
- Annotate and dimension drawings using AutoCAD’s automated annotation and dimensioning features.
- Create section views utilizing AutoCAD’s predefined and custom hatch and pattern fills.
- Utilize and manage CAD standards including:
  - Layers
  - Linetypes
  - Text styles
  - Dimension styles
- Coordinate drawing information with other team members using external reference files.
- Create and manage symbol libraries using AutoCAD’s DesignCenter and Tool Palettes.
- Output your drawings to different plotting devices with specific colors and lineweights.
- Share information with other Windows Office applications using Object Linking and Embedding (OLE).

**Fundamental CAD Concepts**

Because CAD-based drafting is a digital pursuit, some of the concepts that apply to its analog “on the board” cousin are a bit different. It is important that you are aware of and understand these concepts before we begin any drawing.

**Drawing Actual Size**

Board drafting requires that you select a scale before you begin a drawing. This is to ensure that whatever it is that you are drawing fits properly on the selected paper, or **sheet size**.

Large objects are scaled down so that you can see the complete design on the sheet while smaller objects are scaled up so that you can clearly discern finer details.

Unlike drawing on the board, CAD-based drafting does not require design information to be scaled as it is drawn. Everything is drawn actual size as it exists in the real world. This means that the layout of a floor plan that is 100’-0” × 50’-0” is actually drawn 100’-0” long × 50’-0” wide in AutoCAD. The scaling process occurs when the drawing is being set up to be printed or plotted to ensure that your drawing fits properly on the desired sheet size.

See Appendix A for detailed information about standard sheet sizes.
Using CAD, you have a theoretically infinite amount of space within your CAD drawing file to create your design. A drawing can be as large as our entire solar system or small enough to fit on the head of a pin. To help navigate within this infinite drawing space, AutoCAD provides a number of display tools that allow you to zoom and pan around a drawing similar to the zoom and pan functions found on a camera. This allows you to zoom up close to your drawing for detailed work or zoom out so that you can view the complete drawing.

The Cartesian Coordinate System

The primary means of locating information in an AutoCAD drawing is the Cartesian coordinate system. The Cartesian coordinate system is a grid-based system where points are represented by their $X$ and $Y$ coordinate values separated by a comma as follows:

$$X,Y$$

For example, a point located at $X=4$ and $Y=2$ is represented as follows:

$$4,2$$

There is also a $Z$ coordinate, but we’ll talk about that later. For now, think of your computer screen as a 2D sheet of paper where the origin of the coordinate system $(0,0)$ is in the lower left-hand corner of your screen as shown in Figure 1-3.

Positive $X$ and $Y$ coordinate values are represented in the upper right quadrant of the grid. Because it is easiest to work with positive coordinates exclusively, this is where most of your drawings will be created.

![Figure 1-3 The Cartesian coordinate system](image)
Right-Hand Rule

As alluded to earlier, the Cartesian coordinate system also has a Z coordinate that is used to locate points in 3D space. The Z-axis runs perpendicular to the XY plane shown in Figure 1-3.

The easiest way to represent this concept is to rely on what is known as the right-hand rule—it’s as easy as 1-2-3.

To start, clench your right hand into a fist with your palm facing towards you.

1. Extend your thumb to the right.
2. Uncurl your pointer finger so that it points straight up.
3. Uncurl your middle finger so that it points towards you.

Your hand should now look similar to the one shown in Figure 1-4. Using the right-hand rule, your thumb represents the positive X-axis, your pointer finger represents the positive Y-axis, and your middle finger represents the positive Z-axis.

![Figure 1-4: The right-hand rule](image)

Your palm, and by extension, your computer screen, represents the 2D XY plane where Z=0. Using this analogy, positive Z values are towards you, or above the screen, while negative Z values are away from you, or into the screen.

By default, the Z coordinate value is set to 0. Because of this, there is no need to specify a Z coordinate value when you locate 2D points. If the Z coordinate is omitted, it is interpreted as 0. For instance, to locate a 2D point where X=4 and Y=2 you can enter either of the following:

4, 2, 0 or 4, 2

Of course, it makes sense to type the least amount as possible, so all examples in this book rely on the shorthand version.

In AutoCAD, the default Cartesian coordinate system explained in this section is referred to as the World Coordinate System, or WCS. It is possible to change the origin and orientation of the X, Y, and Z axes for high-level drawing operations by creating your own temporary User Coordinate System, or UCS. Creating and modifying User Coordinate Systems is beyond the scope of this book. For more information please consult the AutoCAD help.

**World Coordinate System (WCS):** The default coordinate system in AutoCAD upon which all objects and user coordinate systems are based.

**User Coordinate System (UCS):** A user-defined variation of the World Coordinate System.
Grid Units

In AutoCAD one unit on the Cartesian coordinate grid system can represent whatever you want it to represent. A unit can be 1 inch, 1 foot, 1 millimeter, 1 meter, 1 nautical league, or even 1 parsec. Fortunately for us, the majority of the drafting and design world works in either inches (Imperial) or millimeters (Metric) where the following applies:

**Imperial:**
1 grid unit = 1 inch

**Metric:**
1 grid unit = 1 millimeter

There are of course exceptions to this unwritten rule, most notably the civil design field. Because civil engineers work with drawings that cover large areas (parcel plans, highway plans, etc.) it is common for them to work in decimal feet or decimal meters where the following applies:

**Imperial:**
1 grid unit = 1 foot

**Metric:**
1 grid unit = 1 meter

Unless otherwise noted, most of the examples and drawing problems in this book will rely on 1 unit = 1 inch for Imperial type drawings and 1 unit = 1 millimeter for Metric type drawings.

Angle Measurement

By default, angles in AutoCAD are measured counterclockwise from 0°, which is due east, or right, on the positive $X$-axis as shown in Figure 1-5. Using this system of angle measurement, 90° is north, 180° is west, and 270° is south. It is possible to change the default 0° base angle to any of the other three compass directions, or a custom angle, as well as change the default angle measurement direction from counterclockwise to clockwise.

**Figure 1-5** AutoCAD base angle and direction
AutoCAD provides five different types of angle unit settings so you can enter angles in a format that applies to the type of work you are doing. Most architects and engineers prefer angles in decimal units (i.e., 45.00°), or degrees, minutes, and seconds (i.e., 45°00'00''), while those in the civil engineering world rely on surveyor units (i.e., N45°00'00'E).

**Exercise 1-1: Using Cartesian Coordinates**

1. Using pencil and paper, lay out a Cartesian coordinate grid system similar to the one shown in Figure 1-3.
2. Draw a line from the coordinate point (2,1) to the coordinate point (4,5).
3. Draw a line from the origin (0,0) at an approximate angle of 135° to the edge of the grid.
4. Draw a line from the coordinate point (2,1) to the origin (0,0).
5. Draw a line from the origin at an approximate angle of -30° to the edge of the grid.

**Scale Factor**

As mentioned earlier in the section “Drawing Actual Size,” the lines, circles, and other geometry that represent your design are drawn to their exact “real-world” specifications; the scaling occurs when you set your drawing up to plot on the desired sheet size.

To accommodate this scaling process, the size of annotation features such as text and dimensions must be adjusted accordingly when they are added to your drawing. This ensures that they print out at the correct size after they are scaled up or scaled down. Most organizations rely on drafting standards that define specific text heights, arrowhead sizes, and other annotation specifications so that drawings maintain a consistent appearance. The proper scaling of annotation features is very important so that drafting standards are always maintained.

As an example, annotation features on a drawing that is going to be scaled to 1/2 of its original size when it is printed must be scaled up by the reciprocal of 1/2, or 2 times, when they are created. With this in mind, if your drafting standards require that text print out 1/8" high, you must apply the following formula:

\[
1/8'' \times 2 = 1/4'' \text{ high text}
\]

When the drawing is then plotted, the 1/4"-high text is scaled by 1/2 and prints out at the correct standard text height of 1/8". See Figure 1-6. In this example, 2 is considered the scale factor. The *scale factor* is the reciprocal of the plotted scale. Calculating the scale factor in the preceding example is easy because the plotted scale is a simple ratio of 1:2. It’s obvious that the reciprocal of 1:2 is 2.

**FOR MORE DETAILS**

See Appendix A for more information about standard annotation specifications.
Object Properties

In AutoCAD, the lines, circles, text, dimensions, and just about everything else that make up a drawing are commonly referred to as objects. All these drawing objects have properties associated with them that control their appearance and behavior. Some properties are unique to a particular type of object, especially properties that relate to an object’s geometry. For example, a circle object has a radius while text has a height. Other object properties are shared by all the objects in a drawing. These general object properties are introduced in the following sections.

Layers. Before the advent of CAD, drafters and designers used to coordinate their drawings by physically overlaying them on top of each other. The paper, known as vellum, was translucent so that as you layered each drawing on top of the previous one, the drawing(s) underneath were still visible. This allowed the drafters and designers to compare the work on each individual drawing and coordinate them as a complete system. See Figure 1-7.

Figure 1-7 Overlay drafting
Flash forward to the digital world of the twenty-first century. Using CAD, this concept of physically “layering” multiple drawings one on top of another has morphed into the ability to separate distinct drawing information using named layers. Typically, the name of the layer reflects the type of information that resides on it. For instance, a layer named WALL might contain drawing information that relates to the walls of a floor plan, while a layer named DOOR might contain the lines and arcs that represent the doors. In fact, numerous standard layer-naming conventions and guidelines have been created that allow people to share CAD drawings and understand what type of drawing information resides on each layer.

CAD-based layers provide much more functionality and control than their analog vellum-based cousins. Layers in CAD can be turned off and on so that you can create multiple views of your drawing information. For instance, text and dimensions can be put on their own unique layers so that they can be turned off when you want to concentrate on your design. Similar drawing information can be grouped on specific layers so that you can coordinate between different disciplines. The electrical wiring might be located on a layer named ELEC while the mechanical heating ductwork might be located on a layer named HVAC. Basically, layers give your drawings a level of intelligence that allows you to indicate what objects in a CAD drawing represent in the real world.

Besides controlling the visibility of drawing information, layers also can be used to control the color, linetype, and lineweight of an object. You can even use layers to determine whether an object is plotted or not.

**FOR MORE DETAILS** Layer property management is discussed in greater detail in Chapter 6.

**Colors**

Colors serve two purposes in an AutoCAD drawing:

1. They separate drawing information so that it is easily identifiable on the computer screen.
2. They allow printing and plotting with specific line thicknesses.

The first use of colors is fairly obvious. One of the easiest ways to differentiate between different drawing information on the computer screen is by using color. You might set up your drawing so that all the walls are green, the doors are blue, and the text is yellow. This color coding makes your drawing easier to comprehend and work with.

The second use of colors might seem a bit obscure to many new AutoCAD users—to control line thicknesses when plotting. This use of colors was introduced very early on in AutoCAD’s life as one of the only means of plotting a drawing with varying line thicknesses, a necessity for most organizations. This color-based approach to controlling lineweights is still in use today because of the time and effort necessary to update legacy systems. For this reason, it is a good idea to at least have a basic understanding of how the color-based approach works.

**FOR MORE DETAILS** See Appendix A for detailed information about standard line thicknesses.

Without getting into too much detail, color-based plotting is based on the fact that each color in AutoCAD is associated with an integer value. This relationship is referred to as the AutoCAD Color Index, or ACI. The ACI consists of 255 colors numbered from 1 to 255, with the first seven colors represented as follows:

1 = Red
2 = Yellow
3 = Green
4 = Cyan
plot style: A collection of property settings that is applied when the drawing is plotted to control the appearance of the drawing objects on the printed drawing.

In the early days, plotting was done on pen plotters using numbered ink pens with varying pen tip sizes that plotted with different line thicknesses. The numbered plotter pens were associated with the information in the drawing via the object’s color. For example, red drawing objects plot with pen #1 because the color red = 1 in AutoCAD’s Color Index. This color-to-plot pen relationship is referred to as a plotter’s “pen mapping.” Thankfully, this antiquated approach to controlling plotter pens is quickly being heaped on the trash bin of history as the much simpler approach of using AutoCAD’s linewidth property becomes more popular.

**FOR MORE DETAILS**
Plotting with linewidths and plot styles is discussed in detail in Chapter 14.

**Linetypes**
Manually drawing objects with different linetypes on the board is a very tedious process, if not an art form. A mechanical pencil and a scale must be utilized so that you can accurately measure out the dashes, dots, and/or gaps over the distance of a line.

**FOR MORE DETAILS**
See Appendix A for a detailed description of different linetype standards.

Fortunately, AutoCAD provides more than 40 different predefined linetypes that can be applied directly to your line work with a click of a button. Figure 1-8 shows examples of linetypes that come with AutoCAD.

![Examples of default AutoCAD linetypes](image)

**Figure 1-8** Examples of default AutoCAD linetypes
Chapter 1 Introduction to AutoCAD

The dashes, dots, and gaps that make up a linetype definition are also affected by the scale factor described earlier. Their size must be adjusted to accommodate the plot scale in the same fashion as the other annotation features in order for them to print out at the right size.

**FOR MORE DETAILS**

Linetypes and linetype scaling is explained in detail in Chapter 6.

**Lineweights**

In AutoCAD, the term lineweight is used to refer to a line's thickness. Different drafting standards dictate how line thicknesses should be applied in technical drawings.

**FOR MORE DETAILS**

See Appendix A for detailed information regarding line thickness drafting standards.

Drawing different line thicknesses on the board requires that you use different pencils with different lead thicknesses. AutoCAD provides graphical lineweights that you can assign to your line work, which allows you to see different line thicknesses on the screen before you plot your drawing. There are more than 20 different lineweights available in both Imperial (inches) and Metric (millimeters) format.

**FOR MORE DETAILS**

AutoCAD lineweights are discussed in detail in Chapter 6.

**Controlling Object Properties.** The common approach to controlling the general object properties discussed in the previous sections is to set the desired object property active, or current, before drawing an object. An object assumes the current object properties when it is drawn. This does not mean you cannot change an object's properties after it is drawn. In fact, there are a multitude of tools in AutoCAD to help you accomplish this.

**FOR MORE DETAILS**

Controlling AutoCAD object properties is discussed in detail in Chapter 6.

**Exercise 1-2: Researching CAD Layer Guidelines**

1. Using the Internet, search for Websites with information about the “AIA layer guidelines.” (Note: AIA is the abbreviation for the American Institute of Architects.)
2. Describe the AIA layer-naming scheme and how it is organized.
3. Find an example of at least one other layer standard or guideline.

**Model Space and Paper Space**

AutoCAD has two distinct drawing environments: model space and paper space. Model space is the 3D drawing environment described in the “Cartesian Coordinate System” section earlier that is used for the drawing model, or 3D representation of your design. Model space contains most of the line work, text, and dimensions that make up a drawing.
A FIRST LOOK AT AUTOCAD

Now that we have the preliminaries out of the way, it’s time to start AutoCAD so we can take the grand tour. AutoCAD is one of the more complex Windows programs. There are a myriad of commands, menus, toolbars, palettes, and dialog boxes. The following sections explain all these features and how they work so you can get the most out of the AutoCAD user interface.

Starting AutoCAD

Like most Windows programs, there are multiple ways to start AutoCAD. The three most popular methods are explained next.

Using the Start Menu. The traditional method of starting a Windows program is to rely on the Start menu.

To start AutoCAD via the Start menu, select the Start button on the Windows task bar and select the All Programs icon so all the programs installed on your computer are displayed. Open the AutoDesk folder to see all your installed AutoDesk programs and then select the AutoCAD icon as shown in Figure 1-10.

Paper space is the 2D environment used for laying out different views of the model space information on a standard sheet size and scale for plotting purposes. This 2D page setup is known as a layout in AutoCAD and typically consists of one or more views of your drawing along with a border and title block.

Metaphorically speaking, an AutoCAD paper space layout can be thought of as a 2D sheet of paper that hovers over your 3D model space drawing. Scaled views are created by cutting holes in the paper so you can see the 3D drawing model below. See Figure 1-9.
Using the AutoCAD Program Icon. One of the quickest and most convenient ways to start AutoCAD, or most Windows programs for that matter, is to click on a program icon on your Windows desktop. Typically, when you install a program it will create a program icon on your desktop as well as add it to the Start Menu. The standard AutoCAD icon is shown in Figure 1-11.
If you do not have an AutoCAD program icon on your desktop, you can easily create one from the Start menu by right-clicking on the AutoCAD icon shown in Figure 1-10 and dragging and dropping it on your desktop. When you release the right mouse button the shortcut menu shown in Figure 1-12 is displayed. Make sure you select Copy Here or Create Shortcuts Here from the shortcut menu; otherwise the original program shortcut will be removed from the AutoCAD folder and put on your desktop.

**TIP**

When you install a new program, Windows associates the program’s three-letter file extension (i.e., .DWG) with the program so that you can double-click on a file in Windows Explorer and the program will automatically start and open the file.

Double-clicking on a .DWG file in Explorer will start AutoCAD and open the drawing. Double-clicking on a .DOC file starts Microsoft Word, while double-clicking on a file with an .XLS extension starts Excel. There are literally thousands of different file extensions and associations. You can typically discern what program is associated with a file by looking at the Type column in Windows Explorer when files are displayed using the detailed view as shown in Figure 1-13.

**Figure 1-12** Shortcut menu

**Double-Clicking on a Drawing File.** When you install a new program, Windows associates the program’s three-letter file extension (i.e., .DWG) with the program so that you can double-click on a file in Windows Explorer and the program will automatically start and open the file.

Double-clicking on a .DWG file in Explorer will start AutoCAD and open the drawing. Double-clicking on a .DOC file starts Microsoft Word, while double-clicking on a file with an .XLS extension starts Excel. There are literally thousands of different file extensions and associations. You can typically discern what program is associated with a file by looking at the Type column in Windows Explorer when files are displayed using the detailed view as shown in Figure 1-13.

**Figure 1-13** Starting AutoCAD by double-clicking on a file

**AutoCAD File Types.** By default, a drawing in AutoCAD is saved as a file with a .DWG file extension. For example, a floor plan drawing might be saved with the file name:

Floor Plan.dwg
A file name can be up to 256 characters long and can include most of the alphanumeric characters, including spaces ( ), dashes (-), and underscores (_). A file name **CANNOT** include any of the following special characters:

`\ / : * ? > <`

Windows is not case sensitive, so you can mix uppercase and lowercase letters when naming a file and Windows will not distinguish between them. For instance, the file name in the example above:

`Floor Plan.dwg`

is the same as

`FLOOR PLAN.DWG`

Proper file naming, and by extension, proper file management, is one of the most important aspects of using CAD effectively.

By default, every time you save a drawing in AutoCAD a backup file with the .BAK file extension is created. The backup file is the last saved version of the .DWG drawing file. This allows you to always have the last saved version of your drawing to “roll back” to if something happens to the current .DWG file. Use the Drawing Recovery Manager found on the Drawing Utilities flyout menu on the file pull-down to retrieve a backup file.

Some of the other common file types and extensions used by AutoCAD are listed in the following table.

<table>
<thead>
<tr>
<th>AutoCAD File Types</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File Extension</strong></td>
</tr>
<tr>
<td>AC$</td>
</tr>
<tr>
<td>BAK</td>
</tr>
<tr>
<td>DWG</td>
</tr>
<tr>
<td>DWF</td>
</tr>
<tr>
<td>DWL</td>
</tr>
<tr>
<td>DWS</td>
</tr>
<tr>
<td>DWT</td>
</tr>
<tr>
<td>DXB</td>
</tr>
<tr>
<td>DXF</td>
</tr>
<tr>
<td>PLT</td>
</tr>
<tr>
<td>SV$</td>
</tr>
</tbody>
</table>

If you are unsure of a file type, consult the Windows Help and Support Center.
The AutoCAD User Interface

Because AutoCAD is a program for drawing, the focal point of the user interface is the drawing window. This is where you create your drawing. Everything else surrounding the drawing window helps you accomplish this task. Figure 1-14 shows the major features of the AutoCAD user interface.

The Drawing Window. As mentioned, the drawing window is where you create your drawing. It is the infinite space where you create the lines, circles, and text utilizing the Cartesian coordinate system explained earlier.

Mouse Crosshairs. The mouse pointer crosshairs in the drawing window are used for locating points and selecting objects when you are working in a drawing. The mouse crosshairs switch back to a pointer when the mouse is outside of the drawing window.

The Model Tab. The Model tab represents the 3D model space environment that is used to create the drawing model, or 3D representation, of your design. Model space is explained earlier in the chapter in the section “Model Space and Paper Space.” Clicking on the Model tab makes model space active.

The Layout Tabs. The Layout tabs represent the 2D paper space environment that is used for laying out different views of the model space information for plotting purposes. Layout1 and Layout2 are the default layouts in a new drawing. Controlling and managing layouts is explained in detail in Chapter 13. Clicking on a Layout tab makes paper space active for that layout.

The UCS Icon. The UCS icon represents the current User Coordinate System (UCS). By default, AutoCAD utilizes the World Coordinate System (WCS) explained earlier. The UCS icon can be set to stay anchored to the origin at 0,0,0 or to always be located in the lower left-hand corner of the screen.

Workspaces. The Workspaces toolbar allows you to set the current workspace. Workspaces control the current pull-down menu, toolbar, and palette settings. The AutoCAD Classic workspace is the default workspace for working in the traditional 2D environment.
Pull-Down Menus. The pull-down menus across the top of the AutoCAD window provide access to most of the AutoCAD commands. You'll notice that the menus are organized in the same order from left to right as other Windows programs like Word and Excel. The File menu is on the far left and the Help menu is on the far right, with many of the same menus in between (Edit, View, Insert, Format, Tools, and Window). Most of these menus contain similar commands and behavior.

Putting your mouse pointer over a pull-down menu heading and clicking the mouse will display the pull-down menu. The File pull-down menu is shown in Figure 1-15. To select a menu item on a pull-down menu, position your mouse over the desired menu item so it is highlighted and then click with your mouse.

Figure 1-15  The File pull-down menu

It is also possible to select a menu item via the keyboard by selecting the <Alt> key on your keyboard in combination with the underlined character on the pull-down menu. For instance, the File pull-down menu can be displayed by holding down the <Alt> key in combination with the F key on your keyboard. You can then select the desired menu item by hitting the key for the underlined letter in the menu label. Hitting the N key while the File pull-down menu is displayed selects the New... menu item.
Part One  An Introduction to AutoCAD

**Cascading Menus.** Menu items with an arrow on the right indicate a cascading submenu. Simply placing your cursor over a menu item with an arrow will display the cascade menu. The **Drawing Utilities** cascade menu from the **File** pull-down menu is shown in Figure 1-16. The three dots, or ellipses, next to a menu item indicate that a dialog box is displayed when that menu item is selected. Dialog boxes are explained in the next section.

![Cascading pull-down menu](image)

**Figure 1-16**  Cascading pull-down menu

**Toolbars.** They say a picture is worth a thousand words. Toolbars provide an easy-to-use graphical interface to most of the AutoCAD commands by using pictures called toolbar icons to represent different commands. The **Standard toolbar** is shown in Figure 1-17. You will probably recognize some of the icons from other Windows programs. Toolbar buttons provide the quickest access to a command because they only require one click of the mouse.

![Standard toolbar](image)

**Figure 1-17**  The Standard toolbar
Hovering your mouse pointer over a toolbar button will display a brief description of the toolbar button and what it does. See Figure 1-18. This text is referred to as a tooltip and can be toggled on and off. Even more descriptive information is displayed in the Status Bar at the bottom of the AutoCAD window. The Status Bar is detailed later in this section.

Figure 1-18  Tooltip displayed

**Toolbar Flyouts.** A toolbar button with a small arrow indicates that it is a toolbar flyout. A toolbar flyout button displays a subtoolbar with additional buttons when it is selected. It is the toolbar equivalent of a cascading menu. In Figure 1-19 the Zoom toolbar flyout is shown.

Figure 1-19  Zoom toolbar flyout menu

The last toolbar button selected on a toolbar flyout menu will become the button shown on the main toolbar after it is selected. This means that the next time you need the command you don’t have to display the flyout menu; you can select it from the main toolbar.

**Turning Toolbars On and Off.** AutoCAD has almost thirty toolbars that can be turned on and off as needed. By default, the first time you start AutoCAD the following toolbars are turned on:

- **Standard** toolbar—Contains standard commands
- **Layers** toolbar—Used to manage layers in a drawing
- **Properties** toolbar—Used to manage object properties
- **Styles** toolbar—Used to manage styles in a drawing
- **Draw** toolbar—Contains drawing commands
- **Modify** toolbar—Contains modify commands
The easiest way to turn toolbars on and off is to simply right-click with your mouse when the mouse pointer is over a toolbar button. This displays the **Toolbar** shortcut menu shown in Figure 1-20 that lists all the toolbars with a check mark next to those that are currently on.

![Figure 1-20](image)

**Figure 1-20** Turning toolbars on and off

Selecting a toolbar that is not currently checked will turn it on and place it on the screen wherever it was located when it was last displayed. You can then move it and place it where you want using the techniques explained in the next section.

**Moving and Placing Toolbars.** Toolbars can exist in two states—floating and docked. Floating means that the toolbar is located somewhere (floating) over your drawing window with the title shown at the top and the window-close “X” visible in the upper right corner. The **Dimension** toolbar is shown floating in Figure 1-21. When a toolbar is floating you can move it by placing your mouse pointer over the title bar on top, clicking with your left mouse button, and dragging the toolbar where you want it.

You can dock a toolbar by dragging it to any side of the drawing window. In Figure 1-21 the **Draw** and **Modify** toolbars are docked. To dock a toolbar simply drag it to any of the four sides of the drawing window until the shadow line changes shape, indicating it is ready to be docked, and then release the mouse button. In Figure 1-22 the **Dimension** toolbar has been docked on the left side of the screen. To float a toolbar that has been docked select the grab bars (Figure 1-22) at the top or left side of the toolbar with your mouse pointer and drag the toolbar into the drawing window to the desired location.

**The Command Line Window.** The **Command Line** window provides access to the AutoCAD command line. See Figure 1-23. The AutoCAD command line allows you to enter AutoCAD commands by typing them on the keyboard. It is also one of the ways AutoCAD communicates with you via command prompts and messages.
Entering Commands via the Keyboard. In addition to entering commands using the pull-down menus and toolbars explained earlier, AutoCAD commands can also be entered by typing them at the keyboard. For instance, the command to draw a line can be entered by typing `Line<Enter>` at the command line as follows:

Command: `Line<Enter>`
AutoCAD commands are not case sensitive so you can enter any combination of uppercase and lowercase characters with the same result.

AutoCAD also provides a feature called AutoComplete that allows you to begin typing a command and then press the <Tab> key to cycle through all the commands and system variables that start with the letters you typed.

For example, type DIM<Tab> at the command prompt to cycle through all the commands and system variables related to dimensioning.

Most commands can also be abbreviated to speed up their entry. The abbreviated version of a command is known as a command alias.

Typically, the command alias is the first one or two letters of the full command. The abbreviation for the line command is L:

Command: L<Enter ↓>

A complete list of command aliases is provided in Appendix C.

**TIP**

Hitting the <Enter ↓> key when no command has been typed will reenter the last command. This is a timesaving device that allows you to enter the same command repeatedly. For this reason, the most productive way to work in AutoCAD is to group like operations together. This allows you to "stay in the command" without losing focus jumping around to other menus, toolbars, and commands. Always try to focus on one operation.

**Entering Command Options at the Command Line.** Many commands have options that the user can select by entering a designated response using the keyboard. Options are always displayed as a list in square brackets with each option separated with a forward slash. The ZOOM command prompts you with the following options at the command line:

Specify corner of window, enter a scale factor (nX or nXP), or [All/Center/Dynamic/Extents/Previous/Scale/Window/Object] <real time>:

Options can be entered by typing in the complete option keyword, or more simply, by typing in whatever letter is capitalized in the option keyword. For example, to use the ZOOM command with the Window option you can enter either Window or W in response to the Zoom command prompt. The Previous option can be entered as P, the Extents option is E, and so on. Obviously, typing a shortened abbreviation is faster than typing the complete word so their liberal use is suggested.

**Default Command Options.** Sometimes a command will display a default option indicated with the option displayed between angle brackets. The default can be selected by simply hitting the <Enter ↓> key. For instance, the default option for the ZOOM command is always <real time>. This means if you simply hit the <Enter ↓> key in response to the ZOOM options prompt, you will be automatically placed in the Zoom Real-time mode.

**Note:**

The space bar at the bottom of the keyboard works exactly the same as the <Enter ↓> key in AutoCAD. Because it is larger, some people prefer using it over the <Enter ↓> key because it is easier and faster to get to. The space bar is especially helpful when used as described in the Tip above to repeat commands!
Chapter 1 Introduction to AutoCAD

AutoCAD remembers some command options so you don’t have to type them the next time you use the command. For example, the default radius for a circle always reflects the radius you entered the last time you created a circle. The following is a CIRCLE command prompt with the default set to 2.0000 units.

Specify radius of circle or [Diameter] <2.0000>: <Enter >

If you are creating another circle with a radius of 2.0000 units, hit the <Enter > key, and voilà!

Canceling a Command with the <Esc> Key. The <Esc> key at the top left of the keyboard cancels, or aborts, an active command. It is probably the most used keyboard key in AutoCAD! When you hit the <Esc> key the current command is immediately aborted and the word *Cancel* is displayed at the command line as follows:

Command: *Cancel*

Hitting the <Esc> key will also “unselect” any objects that are currently selected in the drawing window.

The Command History. AutoCAD remembers every command entered in an AutoCAD session from the time you start AutoCAD up until the very last command you enter. This is known as the command history. You can scroll backward and forward through the command history using the arrow keys on your keyboard. The up arrow scrolls backward through the command history, while the down arrow scrolls forward. You can scroll backward or forward to any command in the history and run it again by hitting the <Enter > key.

Resizing and Moving the Command Line Window. Like toolbars, the command line window can be resized, moved, and even made to float. To resize the command line window so you can see more lines of text, place your mouse pointer over the horizontal lines that separate the command line window from the drawing window so that the pointer switches into a double arrow. Hold down your left mouse button and drag up or down and the window size changes accordingly.

To move the command line window place your mouse point over the vertical grab bars on the far left, then pick and drag the window out into the drawing window. See Figure 1-24. Just like toolbars, the command line window can also be docked on any of the four sides of the drawing window. It is typical to dock it at either the top or the bottom of the drawing window.

Turning the Command Line Window off. The Command Line Window can be turned off and on via the Tools pull-down menu or the <Ctrl+9> keyboard combination. When the Command Line Window is turned off, commands can still be entered using the keyboard using Dynamic Input explained in the next section.

The Full Text Window. It is possible to switch to a larger separate command line window known as the Text window by hitting the <F2> function key at the top of your keyboard. All of the function key toggles are explained later in this chapter. Hitting <F2> once will display the Text window as shown in Figure 1-25. The Text window can be minimized, maximized, and resized using standard Windows techniques. Hitting the <F2> key again toggles the window off.
You'll notice that there is an **Edit** pull-down menu in the **Text** window. If you select it, it displays the menu shown in Figure 1-26.

This menu gives you even more command line options. You can run recent commands, select old commands and paste them to the command line to repeat them, and even copy the complete command history.

**Dynamic Input.** Dynamic Input is a set of related input display features that allows you to enter information near the mouse cursor so you can focus on your drawing instead of constantly switching focus to the command line.
Viewing and Entering Data Near the Mouse Cursor. When Dynamic Input is on, data input occurs at the cursor by toggling between different input fields. Figure 1-27 shows the Pointer Input feature, which allows you to enter X and Y coordinate values right at the cursor. Coordinates are entered by typing the X coordinate value and the Y coordinate value separated by a comma. When you enter the comma the X value is locked and input changes to the Y value. You can also use the <Tab> key to switch between the X and Y values. Hitting <Enter> accepts both values.

Dynamic Input also provides a Dimension Input feature that displays temporary dimensions as you draw that you can dynamically update to create objects **parametrically**. The values that you enter in the Dimension Input fields are the values used to create the object. See Figure 1-28.

![Parameteric Creation](image)

**Figure 1-27** Viewing and entering data near the mouse cursor

The <Tab> key allows you to toggle between the different input fields. For instance, pressing the <Tab> key in the example shown in Figure 1-28 switches the input field from the dynamic length dimension to the dynamic angle dimension as shown in Figure 1-29.
Part One  An Introduction to AutoCAD

Selecting Command Options Near the Mouse Cursor. Earlier we saw that command options can be specified by typing all or part of them at the AutoCAD command line. Using the Dynamic Prompt feature you can select command options using your mouse! If you press the down arrow key on your keyboard a list of the valid command options is displayed near the cursor as shown in Figure 1-30. You can either use your mouse to select the desired option or navigate up and down the list using the arrow keys on your keyboard. Using this method you must press <Enter> when the desired option is indicated.

Right-click Shortcut Menus. AutoCAD is chock-full of right-click shortcut menus like those found in Windows Explorer. They’re everywhere. If you’re ever in doubt, right-click with your mouse and you are bound to find something useful. Some of the more prominent right-click menus are introduced below.

If you right-click with your mouse over the drawing window when no drawing objects are selected the Default shortcut menu shown in Figure 1-31 is displayed.

If you right-click when objects are selected in the drawing window the Edit shortcut menu shown in Figure 1-32 is displayed so that you can modify the selected object(s).

If you right-click when a command is active the Command shortcut menu shown in Figure 1-33 is displayed, providing access to different command options, etc.

Accessing Recent Input. It is possible to access recent command input using the keyboard up and down arrow keys or the right-click shortcut menu shown in Figure 1-34.

Figure 1-29  Using the <Tab> key to toggle through input fields

Figure 1-30  Selecting ZOOM command options using Dynamic Input
### Chapter 1: Introduction to AutoCAD

**Figure 1-31** Default shortcut menu

```plaintext
<table>
<thead>
<tr>
<th>Repeat OPTIONS</th>
<th>Recent Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>CTRL + X</td>
</tr>
<tr>
<td>Copy</td>
<td>CTRL + C</td>
</tr>
<tr>
<td>Copy with Base Point</td>
<td>CTRL + SFT + C</td>
</tr>
<tr>
<td>Erase</td>
<td>CTRL + V</td>
</tr>
<tr>
<td>Paste as Block</td>
<td>CTRL + SHIFT + U</td>
</tr>
<tr>
<td>Paste to Original Coordinates</td>
<td></td>
</tr>
</tbody>
</table>
```

**Figure 1-32** Edit shortcut menu

```plaintext
<table>
<thead>
<tr>
<th>Repeat like</th>
<th>Recent Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>CTRL + X</td>
</tr>
<tr>
<td>Copy</td>
<td>CTRL + C</td>
</tr>
<tr>
<td>Copy with Base Point</td>
<td>CTRL + SFT + C</td>
</tr>
<tr>
<td>Erase</td>
<td>CTRL + V</td>
</tr>
<tr>
<td>Paste as Block</td>
<td>CTRL + SHIFT + U</td>
</tr>
<tr>
<td>Paste to Original Coordinates</td>
<td></td>
</tr>
</tbody>
</table>
```

**Figure 1-33** Command shortcut menu

```plaintext
<table>
<thead>
<tr>
<th>Enter</th>
<th>Cancel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Repeat Options</td>
<td>Recent Input</td>
</tr>
<tr>
<td>Undo</td>
<td></td>
</tr>
<tr>
<td>Snap Overrides</td>
<td></td>
</tr>
<tr>
<td>Erase</td>
<td></td>
</tr>
<tr>
<td>Zoom</td>
<td></td>
</tr>
<tr>
<td>QuickCalc</td>
<td></td>
</tr>
</tbody>
</table>
```
Using the recent input feature is a timesaving feature that allows you to recall recently entered data values so you don’t have to type them again regardless if the values were entered via the keyboard in the first place. AutoCAD remembers all the input values from all the input methods.

**TIP**

If you use the right-click menu to list the recent input when no command is active AutoCAD will display a list of recently used commands.

---

**The Status Bar.** The Status Bar at the very bottom of the AutoCAD window is like a mini-dashboard for AutoCAD. See Figure 1-35. It is used to track your mouse crosshairs’ location in the Cartesian coordinate system, turn drafting aids on and off, display different notification messages, and lock toolbars and palettes.

**Coordinate Display.** The Coordinate display on the far left keeps track of where your crosshairs are located by displaying their Cartesian coordinates at all times.

You can disable the Coordinate display by double-clicking on it with your mouse. There is even a right-click shortcut menu that allows you to switch between absolute and relative coordinates. The difference between absolute and relative coordinates is explained in Chapter 4.

**Drafting Aid Buttons.** The buttons in the middle of the Status Bar toggle different drafting aids on and off. Their usage is explained later in the book. Be aware that they also have different right-click menus associated with them!

**Status Tray Icons.** On the far right is what is known as the Status Tray. The Status Tray contains icons that are used to control settings, including a series of notification balloons that are used to
give you important information. You have probably seen the Communication Center balloon shown in Figure 1-36 displayed from time to time.

![Communication Center notification balloon](image1.png)

**Figure 1-36** Communication Center notification balloon

Communication Center notifies you about information from AutoDesk via the Internet about the following:

- General production information about new releases, etc.
- Product support information
- AutoCAD subscription information if you are subscriber
- Tips and tricks available on AutoDesk websites

You can control the Communication Center settings by double-clicking on the satellite dish icon to bring up the **Configuration Settings** dialog box. This dialog box allows you to control how often Communication Center checks for new information from AutoDesk and to turn off the balloon notification if you don’t want to be bothered.

![Select to Display Status Bar Menu](image2.png)

**Figure 1-37** Turning Status Bar features on and off

---

**TIP**

It is possible to control the display of all the Status Bar features and manage the Status Tray settings by clicking on the arrow on the far right of the Status Bar to display the menu shown in Figure 1-37.
Dialog Boxes. Dialog box is the term used to describe any of the graphical windows displayed in response to a command that allows you to select and specify different command options. AutoCAD has many different dialog boxes. Selecting Open... from the File pull-down menu displays the Select File dialog box shown in Figure 1-38. This dialog box is common to many file-related commands. The common file dialog boxes work very similarly to Windows Explorer explained earlier.

![Select File dialog box](Figure 1-38)

The common file dialog boxes contain a right-click shortcut menu that provides the same commands and options found in Windows Explorer so that you can perform different file operations without leaving AutoCAD.

Palettes. Palettes are separate windows that provide additional AutoCAD functionality. The cool thing is that palettes can be continuously displayed so that you can work between the palette and your drawing, like an artist creating a painting. Because of this capability, palettes have a special feature called Auto-hide that can be set to automatically hide a palette when you are not using it, freeing up valuable real estate in your drawing window for actual drawing.

There are a number of different palettes in AutoCAD:

- Tool palettes
- DesignCenter palette
- Properties palette
- Sheet Set Manager palette
- Markup Set Manager palette

The easiest way to turn the different palettes on and off is via the Standard toolbar buttons shown in Figure 1-39.
Tool Palettes. Tool palettes provide easy access to commands, hatch patterns, and blocks via a series of tabbed palettes as shown in Figure 1-40. You switch to each palette by selecting its corresponding tab. You can either select a Tool palette item by clicking on its icon or by dragging an icon into your drawing window.

Tool palettes are meant to be customized, allowing you to add and organize your own commands, blocks, and hatch patterns. The default content is provided as a sample of what you can do. Creating your own custom Tool palettes with your own blocks, hatch patterns, and commands is discussed later in the book.

DesignCenter Palette. The DesignCenter palettes provide access to information, often referred to as drawing content, located in other drawings. The default configuration is shown in Figure 1-41.
DesignCenter allows you to preview and insert blocks, hatch patterns, and other items from other drawings by dragging and dropping them into your current drawing wherever you need them. Configuring and using DesignCenter is explained in detail in Chapter 15.

Properties Palette. The Properties palette is your one-stop shop for managing the drawing object properties explained earlier. In Figure 1-42, the properties of a line are displayed in the Properties palette.

Sheet Set Manager and Markup Set Manager Palettes. The Sheet Set Manager is used to create and manage AutoCAD sheet sets.

sheet set: An organized and named collection of sheets created from multiple AutoCAD drawing files.
Chapter 1 Introduction to AutoCAD

The Markup Set Manager is used to review and manage a set of marked up, or redlined, drawings that have been saved in the DWF (Drawing Web Format) using Autodesk Composer. Both of these features are beyond the scope of this textbook. For further information about the Sheet Set Manager or the Markup Set Manager please consult AutoCAD Help.

Auto-hide Feature. As mentioned, it is possible to “hide” a palette using the Auto-hide feature. When Auto-hide is on, the palette collapses so only the title bar is visible when your mouse is not over the palette. When you move your mouse back over the palette’s title bar the palette expands so it is completely visible again.

The easiest way to turn the Auto-hide feature on and off is by clicking on the Auto-hide arrow icon at the bottom of the palette’s title bar. Auto-hide can also be turned on and off using the palette Properties shortcut menu explained in the next section.

Palette Properties. Each of the palettes introduced above have similar properties that are controlled by clicking on the Properties icon at the bottom of the palette’s title bar. Selecting the Properties icon on any palette displays a Properties shortcut menu similar to the one shown in Figure 1-43. Using the Properties menu you can turn the Auto-hide feature on and off and indicate whether a palette can be docked or not. A palette can be docked on either the left or right side of your drawing window. The Properties palette is shown docked on the right side of the screen in Figure 1-44.
Transparency. The Tool palettes have a unique transparency property that allows you to see through them so you can see items located below. Transparency can be turned off and on and the intensity level can be set by selecting the Transparency... menu item from the Tool palette’s Properties menu. This displays the dialog box shown in Figure 1-45.

![Figure 1-45](image)

Figure 1-45  Transparency dialog box

Sliding the bar to the left makes the palette harder to see through, while sliding the bar to the right makes it easier to see through. If you want, you can turn transparency off completely by clicking on the Turn off window transparency checkbox.

Locking Toolbars and Palettes. As you can see, manipulating toolbars and palettes is easy—almost too easy. To eliminate any accidental changes, AutoCAD provides the ability to lock toolbars and palettes.

The Lock icon in the Status Tray on the far right of the status bar indicates the current lock status. You can either right-click or double-click with your mouse to display the Lock shortcut menu shown in Figure 1-46.

![Figure 1-46](image)

Figure 1-46  The Lock shortcut menu

Click on the desired menu item to lock that feature. Once any feature is locked the Lock icon changes to the locked status in the Status Tray.

You can also lock toolbars and palettes via the Lock Location cascade menu on the Window pull-down menu.

**TIP**

You can override toolbar and palette locking by holding down the <Ctrl> key while you select the toolbar or palette with your mouse.
Multiple Drawing Interface. AutoCAD has what is known as a Multiple Drawing Interface, or MDI. This just means you can open more than one drawing at a time. This allows you to do things like compare multiple related drawings simultaneously so you can coordinate your work, and even better, copy drawing information between drawings using drag and drop techniques. In order to facilitate these features you must be able to organize your open drawing windows on your screen.

The Window Pull-Down Menu. The Window pull-down menu at the top of the AutoCAD window provides a number of window display options for viewing multiple drawings. The different display options are explained in the following sections.

Cascading Windows. The Cascade option displays all open drawings stacked in a tiered fashion so that you can see all open drawings one on top of another as shown in Figure 1-47. You can then switch to another drawing by simply clicking on the desired drawing’s blue title bar.

Figure 1-47  Cascading drawing windows

Tiling Windows Horizontally. The Tile Horizontally option fills the drawing window with all the open drawings tiled in a horizontal fashion as shown in Figure 1-48.

Tiling Windows Vertically. The Tile Vertically option fills the drawing window with all the open drawings tiled in a vertical fashion as shown in Figure 1-49.

TIP  Tiling the open drawings either horizontally or vertically is best when you need to share information between drawings. With the drawings tiled, you can use drag and drop techniques to copy information from one drawing to another!

FOR MORE DETAILS  Copying information between drawings is discussed in Chapter 7.
Horizontally Tiled Drawing Windows

Vertically Tiled Drawing Windows

**Figure 1.48** Tiling windows horizontally

**Figure 1.49** Tiling windows vertically

**Keyboard Commands.** AutoCAD has a number of other keyboard commands besides the `<Esc>` key that cancels a command in progress and the `<F2>` function key that displays the Text window. Keyboard commands provide quick access to a number of commands and options already available on a pull-down menu, toolbar, or the status bar.
Function Keys. Function keys are the keys at the top of most keyboards that are labeled <F1> through <F12>. The most famous function key is <F1>, which is used to display the Help window in almost every Windows program. We have already seen the <F2> key, which toggles the AutoCAD Text window on and off. The other function keys also work as toggles, mostly as alternates for the drafting aids found on the AutoCAD Status Bar. A complete list of function keys and their associated functions is provided in the following table.

<table>
<thead>
<tr>
<th>AutoCAD Function Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function Key</td>
</tr>
<tr>
<td>F1</td>
</tr>
<tr>
<td>F2</td>
</tr>
<tr>
<td>F3</td>
</tr>
<tr>
<td>F4</td>
</tr>
<tr>
<td>F5</td>
</tr>
<tr>
<td>F6</td>
</tr>
<tr>
<td>F7</td>
</tr>
<tr>
<td>F8</td>
</tr>
<tr>
<td>F9</td>
</tr>
<tr>
<td>F10</td>
</tr>
<tr>
<td>F11</td>
</tr>
<tr>
<td>F12</td>
</tr>
</tbody>
</table>

Control Key Combinations. Control key combinations are created by holding down the <Ctrl> key, typically located on the bottom row of your keyboard, while selecting some other key on the keyboard. For example, holding down the <Ctrl> key and selecting the C key at the same time copies information to the Windows clipboard. A control key combination is typically expressed as <Ctrl>+Key. The copy example above is expressed as <Ctrl>+C.

Like the function keys, control key combinations are provided as a quick alternative to commands found elsewhere in AutoCAD. Some control key combinations are common to many Windows programs, while some are exclusive to AutoCAD. A complete list is provided in the following table.

<table>
<thead>
<tr>
<th>AutoCAD Control Key Combinations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Combination</td>
</tr>
<tr>
<td>CTRL+A</td>
</tr>
<tr>
<td>CTRL+B</td>
</tr>
<tr>
<td>CTRL+C</td>
</tr>
<tr>
<td>CTRL+D</td>
</tr>
<tr>
<td>CTRL+E</td>
</tr>
<tr>
<td>CTRL+F</td>
</tr>
</tbody>
</table>
The Online Help System

AutoCAD provides substantial online help via the standard Windows Help system. You are probably familiar with the standard Windows Help system from using other Microsoft Windows programs. Most Windows programs share the same Help interface to make it easier to find help when you need it most.

As mentioned in the “Keyboard Commands” section, the quickest way to activate the Windows Help system is by hitting the <F1> function key. You can also access Windows Help via
the Help pull-down menu and the Question Mark toolbar icon on the Standard toolbar. Using any of these methods displays the dialog box shown in Figure 1-50.

The Help dialog box is split into two panes. The left side of the dialog box is used to locate different help topics, while the right side of the dialog box displays information about the current topic.

The toolbar at the top of the dialog box provides the following features:

- **Hide**—Toggles the locate pane on the left on and off so you have more space to display the current topic on the right
- **Back Arrow**—Works like the Back button in your Internet browser so that you can display topic information that you previously viewed
- **Forward Arrow**—Works like the Forward button in your Internet browser to allow you to move forward again after using the Back Arrow button
- **Home**—Immediately displays the Help welcome page that is always displayed when you first start the Help system
- **Print**—Allows you to print the topic displayed in the contents pane on the right or the topic selected on the left including all its subtopics
- **Options**—Provides most of the same functionality of the other buttons on the toolbar, including Hide, Back, Forward, Home, and Print. Additional Internet browserlike functionality includes the ability to stop the contents pane from loading, refresh the contents pane, and bring up the Internet Options dialog box. You can also turn search text highlighting on and off.

**Locating Information on a Help Topic.** The tabs at the top of the Locate pane on the left allow you to locate information about a topic using a variety of different techniques. How the different tabs are utilized is explained in the following sections.

**Utilizing the Contents Tab.** The Contents tab organizes help information such as topics, guides, and reference manuals using a Windows Explorer–type interface. Topics are represented with an icon that looks like a sheet of paper with a question mark, while guides and references are represented with icons that look like books. See Figure 1-50.

Similar to Windows Explorer, if you click on the (+) symbol to the left of a book icon a tree is expanded to display the chapters and topics in the book in hierarchical format. Using this method, you locate information about a topic in the same manner you locate information in a
book. Decide which guide or reference manual contains the info you need, then drill down through the chapters and their associated topics until you find what you’re looking for.

For example, information about how to draw lines is found in the User’s Guide by navigating to the “Draw Lines” topic in the chapter titled “Create and Modify Objects” as shown in Figure 1-51.

![Figure 1-51 The Draw Lines help topic](image)

AutoCAD provides the following top-level topics, guides, and reference manuals:

- **AutoCAD Help**—The default Help topic. Provides help on using the Help system with links to General Information topics, other Help files, and resources on the Web
- **User’s Guide**—The online AutoCAD user’s guide with information organized in chapter and topic form
- **Command Reference**—Reference guide that includes all the AutoCAD commands and system variables listed in alphabetical format. Also includes information about command modifiers and various AutoCAD utilities
- **Driver and Peripheral Guide**—Guide to attaching and setting up various hardware devices such as digitizer tablets, printers, and plotters
- **Installation and Licensing Guide**—Information about installing and licensing AutoCAD in a stand-alone or network environment
- **Customization Guide**—Guide for experienced users that provides information about customizing AutoCAD
- **AutoLISP, VisualLISP, and DXF**—Documentation for AutoCAD’s AutoLISP and VisualLISP programming languages along with the DXF file format reference guide
- **ActiveX Automation and VBA**—ActiveX and VBA developer’s guide and reference

**Utilizing the Index Tab.** The Index tab allows you to locate information by typing in a keyword. For instance, to find information about drawing lines you could type “line” in the “Type in the keyword to find:” text edit box on the Index tab as shown in Figure 1-52.

As you type, every topic that starts with the keyword “line” is displayed in the list box below the keyword. Selecting a topic from the list will usually display information in the Contents pane on the right unless multiple rated topics are found. If this is the case, then Topics Found dialog
Enter the Keyword "Line"

is displayed so you can further refine your selection. Selecting “LINE command” in this example displays the Topics Found dialog box shown in Figure 1-53.

Selecting “Draw Lines” in this dialog box will display the same information in the Contents pane as shown in Figure 1-51.

Select the “Draw Lines” Topic

Utilizing the Search Tab. The Search tab allows you to Search Help system for information by asking a question in normal human terms. All you have to do is enter your question or phrase in the “Type in a question and press Enter” text edit box as shown in Figure 1-54.

Selecting the ask button returns a list of topics that should answer your question. Select the desired topic to display it in the Contents pane on the right.

Displaying Information about a Help Topic. When the information you need is located using one of the tabbed methods provided, it is always displayed in the Contents pane, regardless of the technique you used to locate the topic.

The Concepts Tab. The Concepts tab provides detailed information about the selected topic in conceptual format. In Figure 1-55, detailed information about drawing lines in AutoCAD is displayed, including an explanation of what a line is and how it is drawn. Text that is underlined is a hyperlink to related information that when clicked on will take you to that topic.
Part One  An Introduction to AutoCAD

In a simple line with connected segments, each segment is a separate line object.

With **LINE** you can create a series of contiguous line segments.

Each single line segment can be edited separately from the other line segments in a series. You can close a sequence of line segments so that the first and last segments are joined.

You can assign properties to lines including color, linetype, and lineweight. For more information about properties, see Control the Properties of Objects.

You specify the locations that define the endpoints of each line with precision. You can:

- Enter the coordinate values for an endpoint, using either absolute or relative coordinates
- Specify an object snap relative to an existing object. For example, you can specify the center of a circle as one endpoint of the line
- Turn grid snap on and snap to a location

There are other methods for creating precise lines. A highly efficient technique is to offset a line from an existing line, and then trim or extend it to the desired length.

Use polyline objects instead of line objects if you want the segments to be connected as a single object.

See Also

- Use Coordinate Systems (BCS)
- Use Object Snaps

Figure 1-54  The Search tab

Figure 1-55  The Concepts tab
The Procedures Tab. The Procedures tab provides step-by-step instructions, or procedures, related to the current topic. In Figure 1-56, the steps necessary to create a line are shown. If there are no procedures related to the current topic, the Procedures tab will be disabled so it cannot be selected.

![Figure 1-56 The Procedures tab](image)

The Commands Tab. The Commands tab lists any AutoCAD commands and AutoCAD system variables related to the current topic. In Figure 1-57, the commands used to draw different linear objects are shown along with a brief description. Because it is hyperlinked, you can click on the command name to go to the topic page for that command.

TIP

If you are not familiar with the standard Windows Help system, the Help welcome page provides detailed information about how to use help by clicking on the "Using the Help System Efficiently" link in the "General Information" section.

The Info Palette

The Info palette displays “real-time” information known as Quick Help about the current command by monitoring your activities while you work in AutoCAD. To activate the Info palette you can either select it from the Help pull-down menu or use the <Ctrl> + 5 keyboard combination. Using either of these methods displays the default Info palette shown in Figure 1-58.

Once the Info palette is displayed, any commands that you enter will cause the Info palette to display information about that topic. The command may be selected from a pull-down menu or
toolbar, or entered at the command line. For instance, activating the command to draw a line displays information about the LINE command as shown in Figure 1-59.

The Quick Help information shown in the palette constantly updates as you select different commands. For instance, if you start drawing a circle, information about the CIRCLE command replaces the LINE command information.
The toolbar at the top of the Info palette provides the following features:

- **Back Arrow**—Works like the Back button in your Internet browser so that you can display information that you previously viewed
- **Forward Arrow**—Works like the Forward button in your Internet browser to allow you to move forward again after using the Back Arrow button
- **Home**—Immediately displays the Tips on Quick Help information that is displayed when you first activate the Info palette
- **Print**—Allows you to print the information displayed on the Info palette
- **Lock/Unlock**—Locks and unlocks the automatic update feature so that you prevent the information from being updated when you select another command.

The Info palette shares many of the same palette properties discussed earlier, including Auto-hide, docking, and transparency. These properties can be controlled by clicking on the white Properties icon at the bottom of the vertical title bar.

**The New Features Workshop**

The New Features Workshop is a multimedia presentation that provides a series of animated demonstrations, tutorials, and new feature overviews so that you can quickly get up to speed with all the latest and greatest features in the most recent version of AutoCAD. By default, the New Features Workshop is automatically displayed the first time you start AutoCAD. To start the New Features Workshop manually, you must select it from the Help pull-down menu.

**Utilizing Online Resources**

AutoCAD provides direct links to a number of helpful Internet Websites on the Additional Resources cascading submenu located on the Help pull-down menu. Selecting any of the menu items on this menu will start your Internet browser and display one of the following Web pages:

- **Support Knowledge Base**—Link to the AutoCAD Support Website. Features include the ability to search the vast Support Knowledge Base and links to Hot Issues
Part One  An Introduction to AutoCAD

- **Online Training Resources**—Link to the AutoCAD Training Website. Features include links to information about instructor-led training, self-paced training, how-to articles, and various AutoCAD tips
- **Online Developer Center**—Link to the AutoCAD Developer Center that provides information about customizing AutoCAD using the various programming tools provided in AutoCAD
- **AutoDesk User’s Group International**—Link to the AUGI Website

The beauty of utilizing the Online Resources is that it provides you with real-time information. In particular, the **Product Support** link is your best resource for finding out about any bugs, problems, or other issues that show up after AutoCAD has been released. The **Training** link is also especially useful because it provides updated schedules about different classroom and online training opportunities. You will want to make a habit of checking your Online Resources frequently!

**Exercise 1-3:** Exploring the AutoCAD User Interface

1. Start AutoCAD using one of the three different methods explained in this chapter.
2. Select the OK button if the Start dialog box is displayed.
3. Select each pull-down menu so that you can see its contents.
4. Drag the Draw toolbar to the middle of the AutoCAD drawing window.
5. Dock the Draw toolbar on the right side of the AutoCAD drawing window.
6. Hover your mouse pointer over any toolbar button so you can see its tooltip.
7. Right-click with your mouse while it is still over the toolbar button so the **Toolbar** shortcut menu is displayed.
8. Turn on the Dimension toolbar.
9. Select any Dimension toolbar button.
10. Hit the <Esc> key.
11. Resize the command line window so it displays six lines.
12. Hit the <F1> function key.
13. Locate the “Draw Lines” topic using the Locate pane on the left side of the **Help** window.
15. Exit AutoCAD.

**SUMMARY**

The information and concepts explained in this chapter form the basis for the rest of this textbook. Now that you know the basics of AutoCAD you’re ready to begin. The next chapter will get you up and running by showing you everything you need to quickly get started. The rest of the textbook delves into these topics in glorious detail so that you will be an AutoCAD expert by time you’re finished. Good luck and have fun on your journey!

**CHAPTER TEST QUESTIONS**

**Multiple Choice**

1. The main benefit of using CAD is:
   a. Increased productivity
   b. Improved precision
   c. Better collaboration
   d. All of the above

2. When you create a drawing using AutoCAD most of the information that makes up your design should be drawn at what scale?
   a. 1:1
   b. Half scale
   c. Plot scale
   d. None of the above
3. What is the Cartesian coordinate system?
   a. A grid-based system with an X- and Y-axis
   b. A grid-based system with an X-, Y-, and Z-axis
   c. A system for coordinating your work
   d. None of the above

4. The default units in AutoCAD are:
   a. Millimeters
   b. Inches
   c. Feet
   d. Meters

5. By default, angles in AutoCAD are measured:
   a. Clockwise
   b. Counterclockwise
   c. Using radians
   d. Using a protractor

6. How high should text be if it needs to plot at 1/8" high on a drawing that is plotted at a scale ratio of 2:1?
   a. 1/4"
   b. 1/2"
   c. 1/16"
   d. 12"

7. Layers in AutoCAD are used for the following:
   a. Controlling object colors
   b. Organizing drawing information
   c. Controlling an object’s visibility
   d. All of the above

8. The AutoCAD Color Index consists of how many colors?
   a. 7
   b. 256
   c. 255
   d. None of the above

9. Paper space is primarily used for:
   a. Creating 3D models for visualization
   b. Laying out multiple 2D sheets for plotting purposes
   c. Storing extra copy paper
   d. All of the above

10. AutoCAD can be started by:
    a. Using the Start button to navigate to and start AutoCAD
    b. Double-clicking on the AutoCAD program icon
    c. Double-clicking on an AutoCAD drawing file
    d. All of the above

11. The default three-letter file extension for AutoCAD is:
    a. DWL
    b. DWT
    c. DWG
    d. BAK

12. The large window in AutoCAD where you do most of your drawing is known as the:
    a. Graphics display
    b. Drawing window
    c. Command window
    d. Layout

13. To turn toolbars on and off using the Toolbar shortcut menu you should:
    a. Right-click with your mouse in the drawing window
    b. Right-click with your mouse in the command window
    c. Right-click with your mouse over a toolbar button
    d. None of the above

14. The abbreviated version of a command is referred to as a:
    a. Command accelerator
    b. Command shortcut
    c. Command control
    d. Command alias

15. What keyboard key cancels any active command?
    a. <Tab> key
    b. <F1> key
    c. <F2> key
    d. <Esc> key

16. What keyboard key toggles the full text command window on and off?
    a. <F1> key
    b. <Esc> key
    c. <F2> key
    d. <Tab> key

17. What keyboard key toggles between input fields when using the Dynamic Input feature?
    a. <F2> key
    b. <F1> key
    c. <Tab> key
    d. <Esc> key

Matching
• Cartesian coordinate system
• Right-hand rule
• Scale factor

1. 3D drawing environment where most of a drawing’s linework and text reside
2. Main window in AutoCAD where you create and modify drawing objects
3. Grid-based system where points are represented by their X and Y coordinate values
• Layer
• Model space
• Paper space
• Drawing window
• Command window
• Dynamic Input
• Status Bar

4. 2D environment used to lay out a drawing for plotting
5. Technique for visualizing the X, Y, and Z axes
6. Multiplier applied to annotation features like text and dimensions
7. Window that provides access to the AutoCAD command line
8. Feature that allows you to enter input information near the mouse cursor
9. AutoCAD mini-dashboard at the bottom of the AutoCAD window
10. Object property used to organize drawing information

True or False

1. True or False: Using CAD requires that you scale your drawing as you create it so everything will fit on the printed paper size.
2. True or False: You must always specify a Z coordinate when locating 2D points in CAD, even if Z=0.
3. True or False: A grid unit always equals 1 inch.
4. True or False: Angles in AutoCAD are always measured counterclockwise.
5. True or False: Annotation features such as text and dimensions must usually be scaled by the reciprocal of the drawings plotted scale to appear the correct size.
6. True or False: All objects in an AutoCAD drawing have a Layer property.
7. True or False: The Color property of objects can be used to determine the object’s line thickness when it is plotted.
8. True or False: Model space is where you create most of the line work and text that represents your design.
9. True or False: AutoCAD creates a backup file with a BAK extension each time you save a drawing.
10. True or False: The main focus of the AutoCAD user interface is the drawing window.
11. True or False: The command line window can be moved and resized.
12. True or False: It is possible to lock toolbars and palettes so they are not accidentally moved.